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After completion of Higher Secondary (+2) Vocational Engineering (EE) course, students
can pursue the following courses / Jobs / Self-employment as detailed below:

Vocational Stream

The Vocational Engineering students are blessed with two major opportunities after
completing their +2.

Educational Guidance Job Opportunities

BBA in Management Assistant to Company Secretary
B.Com. Office Management Member in Company Secretary Team
B.Sc Management Assistant to Executives in Office
® BA Management Executive Assistant ®
B.Com Corporate Secretaryship Administration Executive
B.Com E-Commerce Front Desk Executive

B.A. (Vocational Studies) Office Management & Office Administrator

Secretarial Practice
Company Secretary
Diploma in Modern Office Management

Diploma in Modern Office Management and
Secretarial Practices

Diploma in Modern Office Practices

Diploma in Modern Office Management and
Computer Application Engineering

Diploma in Modern Office Management and
Secretarial Practices

ACS — Secretary Course

Certificate course in Management
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Geqmeveiv  peuny, SieuT  elletvsmedrerdlet
wnsneodHemnsd Gsibseul LOHMID Sieud
AleiqGLmuT G6qmeb6N.60T LOSEHLD S 6.
SI6UT HITEOT (LPSH60T (PHVleL HLL&F& WIMnilemi
2_e0dNG AMWPSLILIbSSWIEUT Sh6um.

Bhd memL(pemm FLLFH UGSHuled
IHITLD 6TENEUMM)| LIGLILIGUITE SL L &5 (LPEDMDEmLL
Lufebeus) eredTLIemS LMTLIEUMD. &ge60TeLpeoLb,
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QFWWILILIL (b6 S, (LPESWILONS BHITLD SHLL &8
LulebGurg ellenELiLeensemil LITT S8
SHLLES QFLIWS Snl M. [HID eTemSL LM
SLLES aFLHACHTGLM Shg eFdemul (1)
eleuTsHems UNMTSHEIS O&Metoh eflemFenil
Buis@eug sfllmer (Wewm SH@&W. WHd
urrl_g,so)g) %bgmlj]as@w Gurg SymbLll eredTm
a&]sm&@urrg)g)nsmsm 3i(1p58 GeueTuT(HLD.
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31) M| QUNTSSILIMISEM6T AHWIDSHSHED, 66u6leuTeOTNID 5 (pewm Luihd aFiweyD:
1. Whatever you are, be a good one.
2. Be the change you wish to see in the world.
3. Try and fail, but never fail to try.
4. Choose death rather than dishonor.
5. Believe you can and you’re halfway through.
6. A false friend is worse than a bitter enemy.
7. To travel is to take a journey into yourself.
8. I haven’t been everywhere, but it’s on my favorite list.
9. Brief words are best on burning matters.
10. June has put a spirit of youth in everything.
11. Lie down and listen to the crabgrass grow.
12. The earth laughs in flowers.
® 13.  Water is the most precious force of all nature. ®
14. Human beings, must go back to nature for information.

15. Music should strike fire from the heart of human.

2181) Geus LWINHF GFLILIEYD:
1. Hear twice before you speak once.
2. True friendship is a plant of slow growth.
3. I never think of the future it comes soon enough.
4. Hasty resolution seldom speeds well.
5. A poem begins in delight and ends in wisdom.
6. Fear of God is the beginning of wisdom.
7. Long ago I bought a dry gold necklace.
8. Krishna got 2/5 and Varsha 3/5 of their shares.
9. Received 5 sets Table(2’6”) & Chairs (1°6”).

10. Pack my box with five dozen juice mugs.
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3p) EGlp a&MbeSLILLbeTer Am uSHEemeT Lbha (Wwewm Lulnhd aFiiweyb:

(2p2) (Amy) uSHBEWET WHE! (PEOD GEUCIEUTETMID

1.

Tracy looked at the flag. The flag is red, white, and blue. It has fifty white stars, seven
red stripes, and six white stripes.

Donald plays the piano. He loves the piano. He has a big piano in his living room.
His piano is shiny and black. It has three legs and a bench.

This weekend I went to the zoo. It was great. I went with my mom and dad. My sister
came, too. The zoo was in the city. The zoo was very long.

When I was playing today at recess, I felt like a kite blown around by the wind. It
was hard to stay in one place because the wind was so strong.

My teacher is awesome. I think she deserves an award for teaching. I have liked all
my teachers, but she is by far the best I've ever had.

(88) (aupsHsLomneT) USHemI BbHS (PewD SHLLEFS A5G LLP&HED: (66)616UT60T6MDILD)

1.

Indiaisa DEMOCRATICSOCIALIST country in the World. Infect, DEMOCRATIC
SOCIALISM has been offered as a solution to the DEVELOPMENTAL
resolution which India has undertakes to break through the barrier of UNDER-
DEVELOPMENT of carrying forward the liberation of many millions of people
and pushing through the DEVELOPMENT in all spheres of life. The SOCIALIST
transformation which India aspires is that of building an independent, economy
and comprehensive, including agriculture, on a modern technical basis as early
as possible.

“India is my Country. All INDIANS are my Brothers & Sisters. I love my
country and I am proud of its rich and varied heritage. I shall always strive
to be worth of it.

I shall give respect my parents, teachers and all elders and treat everyone

with courtesy. To my Country and My People, I pledge my Devotion. In their
well-being and prosperity alone lies my happiness”.

The question here is, are all of them entrepreneurs? The answer is both yes and
no. If we say that an entrepreneur is a person, then all the above individuals are
entrepreneurs. When we add that a person having his own business only is an
entrepreneur, excepting Kamath and Prabhudeva, all the others are persons having
their own business — small, very small, or large. But we say that an entrepreneur is a
person who starts his own business. Chandrasekaran and Narayanan are taking care
of the business started by their father; so they are not entrepreneurs. Ramu, whose
mother prepares sundal and asks him to go to beach, sell and bring the money and
give it to her, is also not an entrepreneur, but only an employee. Also, if shops and
businesses are not started by them, then they also cannot be called entrepreneurs.
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FLLES uinmd — una Il

1. GausliLwind — S euELD L chenTem LSl enenthg AL SHed S LG8 aFilg)

(P19 HSHEYLD.

a1) The present constitution of India was framed by the Constitution Assembly of India set

up under the Cabinet Mission Plan of May16, 1946. The idea of establishing a Constituent
Assembly to draw up the Indian Constitution was not a new one. The American Constitution
was framed by a Constitution Assembly. In fact, American Constitution has proved to be
a model to the democratic world. Till independence, India was governed under the Acts
passed by the British Parliament. In 1938 Sri Jawaharlal Lal Nehru declared: “The Indian
National Congress stands for independence and a democratic state. It has proposed that
the constitution of free India must be framed, without outside interference, by a constituent
assembly elected on the basis of adult franchise. That is the democratic way and there is no
other way short of revolution, which can bring the needed result. An assembly so elected will
represent the people as a whole and will be far more interested in the economic and social
problems of the masses than in the petty communal issues which affect small groups . ”

The inaugural meeting of the Constituent Assembly of India was held on December
9,1946. It was presided over by Dr.Sachchidananda Sinha who was the oldest member of
the Assembly. On December 11, 1946, Dr. Rajendra Prasad was elected President of the
Constituent Assembly.

On December 13, 1946, Shri Jawahar Lal Nehru moved the “objectives resolution” which
later became the Preamble of the Constitution.

A number of committees submitted reports to the Constituent Assembly on the different
aspects of the constitution. On the basis of these reports the constitution was prepared by
Constitutional Adviser, Sri B. N. Rao. The Drafting Committee under the chairmanship of
Dr.Ambedkar worked on the draft and produced the Draft Constitution with 315 articles
and 8 schedules. The Draft Constitution was considered by the Constituent Assembly. In
its progress through the Constituent Assembly, the constitution grew in bulk and took its
final shape with 395 articles and 8 schedules. The time taken in accomplishing this task
was exactly two years, eleven months and 17 days from the first meeting of Constituent
Assembly on 9" December, 1946 till November 26, 1949 when “We, the people of India”
gave unto ourselves the new constitution.

There have been over 92 amendments to our Constitution so far.

Procedure of Amendment:

The Indian Constitution is a combination of rigidity and flexibility. It has neither the rigidity
of the American Constitution nor the flexibility of the British Constitution. Three different
methods of amendment have been provided under the Indian Constitution.
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First, certain provisions of the constitution can be amended by Parliament by ordinary

legislation. For example, Parliament may, by ordinary law (i.e., a law passed by a simple majority)

form a new State out of the existing States, increase or decrease the area of any state, alter
the name of any State, etc. Again, for abolition or creation of Legislative Councils in States,
Parliament may, by ordinary law, provide for this, provided the Legislative Assembly of the State
concerned passes a resolution to that effect by a majority of the total membership and at least
a two-thirds majority of the members present and voting before Parliament undertakes to pass
such a law.

)

176

Secondly, certain specified provisions can be amended by a special procedure.

In case of the aforesaid order having been made any of the following persons shall be
required to preserve and produce all the books, registers, other documents and records of
and relating to the company/intermediary/other person being in its custody or power: (i)
every manager, managing director, officer and other employee of the company ; (ii) every
intermediary referred to in Section 12; (iii) every person associated with the securities
market. The investigating Authority may also examine any of the aforesaid persons on
oath. Further, Investigating Authority may also examine any of the aforesaid persons on
oath.

Further, investigating Authority may call for information, books, registers or other
documents and records which it considers relevant and necessary for the purpose of its
investigation. It may keep the records produced before it in its custody upto 6 months. It
may issue certified copies of those documents for use of the person on whose behalf the
books and documents have been kept. In case any person referred to above refuses to or
fails to furnish the desired books/records/information or refuses or fails to appear or sign
the notes of any examination, he shall be punishable with imprisonment for a term which
may extend to one year, or with fine, which may extend to one crore rupees, or with both,
and also with a further fine which may extend to five lakh rupees for every day after the
first during which the failure or refusal continues.

Investigating Authority has also been empowered to secure an order for seizure of
books, registers, other documents and record by making an application to the Judicial
Magistrate. Such an application can be made where in the course of investigation, the
investigating Authority has reasonable ground to believe that the books, registers, other
documents and records of, or relating to, any intermediary or any person associated with
securities market in any manner, may be destroyed, mutilated, altered, falsified or secreted.

After considering the application and hearing the Investigating Authority, if necessary;,
the Magistrate may, by order, authorize the Investigating Authority- (a) to enter, with
such assistance, as may be required, the place or places where such books, registers, other
documents and record are kept; (b) to search that place or those places in the manner
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specified in the order; and (c) to seize books, registers, other documents and record it
considers necessary for the purpose of the investigation.

However, in case of a company intended to get its securities listed on any recognized
stock exchange, order shall be passed only if such company indulges in insider trading or market
manipulation. Further, records seized must be returned back to the company/body corporate
after the conclusion of the investigation. Search and seizure, as aforesaid, shall be carried out in
accordance with the provisions of the Cr.P.C. 1973 relating to searches or seizures made under
the Code.
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circa, about, around, from the year

versus, as opposed to

chapter

question answer

example
word words
reference

difference

SIS GSLD (1) Fl6UrhIGLD (Y6OT 2_6iTerT
euny SHemsulledr & (H&eLD:

® B pol - politics
B gov - government
B subj - subject
B info - information
B intro - introduction
2_uilearsens Lmaeuofl $g6:
B prbim - problem
B schl - school
B bkgd — background
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(P19 6UEML LD 6UMT HemSHulled &i(H&&LD

SIM)FHev:

B govt - government
u gov't — government
B interl — international
|

. ' . .
inter | — international

ing emw Lm&600fl S36D:
B ckg - checking

B ckng - checking

| ck'g - checking

QFlLIemM

179

1/14/2020 4:40:59 PM ‘ ‘



S} 6)6T0TH6MG 6L EUEMLD FHF6D

efleorm:

(a)

(b)

(c)

(d)

(e)

180

GuaGLésamId HDhHs SPEHGETITL ieTeYHEBLET il QI LS HpeUTITSHmS
9 _(HEUMTSHSHEYLD.

Uss Sleney — A4
U MhiGerfleor ereooreovfldbemnd — 4

Ged LSS D 1.25 SMIGEDLD HM LUSSHISET 0.75 SihiE60LD

Slp&H&HET0TL. 2_emIemll 2_6iTerfIL 6.
HAPPINESS:

Happiness is often confused with fun, good living, and riches. Sometimes fun is equated
with happiness. Fun is what we experience while doing an activity, whereas happiness is
a residual and long-lasting feeling. The path to happiness is long and full of challenges.
Happiness requires life—-long pursuit.

HAPPINESS eretTeiid semeoliling er(p58 euemauiesr sieney 18 yeraflear, er(pssl
euema Arial, H1q1060T, eMLOW BemE6)] P QUQELL L OHEDETE OFIS.

USHES SPSHSHEITL 6l L EOSHEN6TE C1FILIS.

(a) Font - Arial
(b) Font size - 12

(c) Alignment — Justified

(d) Leading - 20

S} 6LETTT HMS 'happiness' eTeoTn GLwWifled GFLO&HS.
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gl emm:
1. Start > All Programs > Adobe > PageMaker 7.0 > Adobe PageMaker 7.0 eredTm
auflemsuied Heafle agFilg @ UHw CURCLEST SHaUTTHmSS HDEHSEA|D. LLSSH6
srligujetereurm) HCLM CuLGL&EST seiteored Hlemn GHmedTmibd.
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2. ulgtulenLufled File > New erettLemss Slafle asiweyn. (sieveog) Ctrl + N ereorenid
eflemsliLenemns GMNIGS auflemnwill LweTLbSSeD. && Document Setup 2_emmwimLed

QULIgemWS SHMEBGSLID.

B Page Size SYlnig ulleuliquied Hefls aFiigs A4 eeTand USHS
CaihaghéHsaD.
® B Number of pages 2_emrlieLliquied 4 ereor & _aTearfleyw.

B gurhsefler Siememel &p&seToTL 6UMD) LOMHMEYLD.
Inside - 0.75 inches
Outside — 0.75 inches
Top - 1.25 inches
Bottom - 0.75 inches
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3. OK eunsgmemenr &efls asLiwieyD. LULSH6d srLliqujstareurm) Untitled — 1 eteorm ewwirfled
ysw speuevord flemguied CameoTmid.

4. 6L&6VL themend Hefle QFLE QI 2 mISSTGHeOW 2 [Heurssayb. Ing &6
QBM(bSSBLILL(H6TeN _emIemll SHL L& GIFIILIEYLD.
HAPPINESS:
Happiness is often confused with fun, good living, and riches. Sometimes fun is equated
with happiness. Fun is what we experience while doing an activity, whereas happiness is

a residual and long-lasting feeling. The path to happiness is long and full of challenges.
Happiness requires life—long pursuit.
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5. GIL&HEL chemeDSH Q\BHTE00T(h 'HAPPINESS' eTeTUEmS S BHIHOSH & &LD. Character Control
Palette ceold 61058 6uems Arial, 158 euemsuletr siemey 18 LeTeflser, Leading 22
eTeoT LOMHMEYLD. Bold eungsnementd Heafled aFwweyo. U@ emww Qemgadng Shift +
Ctrl + C eretreniid smel G&IonerH6ms SH(QSSHELD.
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6. GIL&6L (hemedSH 6&HMettI(h LHFHemwd CoHImHesHbeHseyw. Character Control Palette
cpeld eT(RSHG euemd Arial, er(pss euemsuiet siarey 12 yeTeflser, Leading 20 ereor
wrppeyw. Ung Criss ensalng Shift + Ctrl + J ereotenid snell G&ILONEITHemS

Si(RSBEYLD.
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7. SH6UETUIHNS 'happiness' eTeoTn elLwifled GaL&Hs

eflemsLiLeemauiled Ctrl + S eTedTLemS Si(RSHSUD Seveod UL lqliL emLuied File > Save
eTeoTLIEMSS Herflé aFliwieyb. Save publication 2_emguwimed ey Gsmeormid. File name
2 _emrlieILLiquied 'happiness' 6T60T HLL &S 615G Save aunssmenerd Hlafls aFiwieD.

eeuerfluicy:

HAPPINESS

Happiness is often confused with fun, good living, and riches. Sometimes fun is
equated with happiness. Fun is what we experience while doing an activity, whereas
happiness is a residual and long-lasting feeling. The path to happiness is long and

full of challenges. Happiness requires life-long pursuit.

w6y
THIUMTTSSLILULL (P196) HeDL S5SHE).
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eleorm:
GugBudsenIll LWeTUbSH SpsdsetorL wmeooreul ML LEDMSHEMW 2 (HEUTEHS.

Student Notice Board

BCuBussemrll LweTUbSE wnevoreul SMlelilyll LeenHemU 2_(HEUTHEH6D.

&L emM:

1. Start > All Programs > Adobe > PageMaker 7.0 > Adobe PageMaker 7.0
areorm euflemsuied Hlefls &S B LS CURCLEST H6UETTSHMSS SMESHELD.

2. ullulenLuied File > New erettuenss Heafle agwweyb. (sedeog) Ctrl + N ereoremid
eflemsliLenems GSMIHS GUPlemIL LWeTLbSSeD. & Document Setup 2_emywimLed
QuULIgemwd HmHGSLD.

3. OK eunggnemen &Hlafle egiwen. @ueung Untitted — 1 eteorm euwirfled L&Hlu
Sp6uetoTd FHlewruied GHmedTmiLd.

4. OISLMMEISHED themeDLl LwemUbSEH 100 mm X 100 mm Siemeysel 6ILLIG 6l 6U6MITLL
Geuetor(hld. iFled fwimedr (Cyan) Bmdemg Hrlueyn. tint wdHlemu 25 Faeigwons
rHoeyd. Sueunes ULl Spésesoreurm GemedTmi.
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5. 8BsBunmedrm 100 MM x 15 MM SiemeyeTen LMHEDTIH GILLLGemUI euemTl GeUeTr(hLD.

® afev &Ly (black) Bmdemg MHirliueyn. @nal eullgenw dwmeor (Cyan) Hmw ®
Briuiuce auliguier Goebu@GHuled emeudbseayb. SUaumgl ULl Sp&esesorLeumm)
GamedTmILD.
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6. 6IL&6L themedd &(HLIL BIDL UL Iquier 8L & @IsHHelmha 6uens @I euemr Hefls

651 8158 Geueturpib. LeoTeur Sigled " Student Notice Board" eT60TM)| SLL&S QFIILI
BeueooT(hlD.
eT(pSSle0r B QUL Iquiledt EIM(PLD Q60TMNS (SBLILMS) S(HHSID. 2_nIeml SLL &5
&g (WSl e Ctrl + A ereitend ellensliLDens GMNIHS Ul CLOEOLD 2_emTemiLl
GaIHOSbhESLD.
Character Control palette cpeold er(psdlenT siememen 20 Leaflsemms wMHmeyD. Bold
uettfls@nlemws Hefld aFweyD. Reverse eunggnemensd Heafld sLFHTED 2 6w
G6uaTeman [HMLOMS LIMID. 2 emIenw enwul Bensey agiw Shift + Ctrl + C eredrend
aflemsliLnems GSMNIGHS Ul LWeTUGbSSRD. @ueurn(es wrssoreul SipleiL
LeDems SpdHeetorLeunm| Hlemruied GHmedTmiL.

eeuefluich:

wey:
THITUMTSSILULL (P96 HeDLSHSE.

QFlLIemM 189

‘ ‘ 12th STD OMS_Tamil version Practicals.indd 189 @ 1/14/2020 4:41:00 PM ‘ ‘



CuaCusal — eldALig M
SMTEML _(H6UTSHEHSHE0

eleorm:
GuBwssemIll LWETUbSHEH SpédsetorL efldliqnm SNTenL 2 (HeUTHE.

S. Barath Kumar

Vision TECH

5, Annai Avenue, Trichy - 17
Ph : 0431 - 2780000

BGuhBLsHasemIL LW6TUbSS 1sMbeBULL(beTen LI nk SMTenL 2 _(HeUTHESSH6D.

gl emm:
1. Start > All Programs > Adobe > PageMaker 7.0 > Adobe PageMaker 7.0 eredtim
auflemsuied Heafles aFLgH @ UHw CURCLEST HeUTTTHMSS SMSHSED. UL SHHeD
srliqujerereurm] SGLIL CuiCasT geoteored Hlewr GHmedTmILD.
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2. ullulenLuiled File > New erettLemss Slafles asiweyn. (sieveog) Ctrl + N ereorenid
eflemsliLenemns GMNIGS auflemnwll LweTL(bSSD. && Document Setup 2_emmwimLed
QuULIgemwS SHMEBGSLD.

QFlLIemM 191

‘ ‘ 12th STD OMS_Tamil version Practicals.indd 191 @ 1/14/2020 4:41:00 PM ‘ ‘



| T T ® . T ||

www.tntextbooks.in

3. OK eunsgmeneor &efls asiwieyD. LULSH6d srliqujstareurm) Untitled — 1 eteorm ewwirfled
yslw speuevord flemguied CameoTmid.

4. @ueunpg sersipbaener Inches edlpbg Milimetersé@ omHmeyLD.
uLigluemLuied File > Preferences > general eredtm &L Lemememwd lerflé G1FWLIGYLD.
(s1eve0g)) eflemsliLeoensuied Cirl + K erettuems sipsseyn. @ueunpg Preferences
2 _emIWIML6d QUL GaHmedTmiLb.
aifled Measurements wpmid Vertical ruler S¥iprig uligleuliquied Milimeters
eTeTUEmS S BHITHOSH(bSH&SHEYLD.
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5. &l auLquiledl[®Hhg OTSLMTRISE hewend CHIHOSH(bSHE FUEUSLD 6UEDITUILD.
6. Control Palette &eb width 95 mm ereoteyd height 55 mm ereoTeYLD LOMHMEYLD.

QFlLIemM 193

‘ ‘ 12th STD OMS_Tamil version Practicals.indd 193 @ 1/14/2020 4:41:01 PM ‘ ‘



| T T ® . T ||

www.tntextbooks.in

7. &@medlauLiguiled 6l1L&6L. chemed Hlerflé FIIWIeYD. HLL & & Geustoriqul & _emruileot
eTebemEemWS GSMILIL eFeueusSHedT BL g cpeneouled(bhal 6UEDS CLPENED EUEDIT
dafles asigH S(1ps5&H6)D.

8. muifleor OUWem 2_6iTerfl(h, SiIemS CIL&H6IVL. ehed cpeold B HIHeGbaH&a. Control Palette
cpeold BHEMEUWITEDT 6T(IR5HG] 6U6ME LOMHMID 6T(RSHSI60T SieTEWEUSH O\BM(b&HSLD. Ll60TEoTIT
6uens| LUmons Anfle HeTSHeUL.
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9. UgFlemed 7 & oMILIGUID QFLIWLIEYD. [HimieuetTSHHle0r CLemT 266l (h, SiemS G SH6vL
thed ceold BaHeSbh&&HeD. Control Palette epevld GsHemeulLITEDT 6T(105 8] 6U6MS LOHMILD
TIPS SeMeMEUSH QBN (HSHSHEYD. LN60Te0TT 6ue0& Lmons SANlg HHTSHSED. (PSH6D
ET(R5HEMS 6IL&H6L ¢hed eLpedld BHIHOSHHSHSI 6T(RSH8I euenSHUetT SieTemer QLIflHT&HSeLD.
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10. ugflemeo 7 & wMLUIGWD QFLwWeD. Hineuersdlern (waeufleww 2 stafl b, Siens
GIL&6IVL ehev epeld Baiihesbhe&a . Control Palette epeoid GsemeuILITEDT 61105 S 6U6M S
LOHMID 6TIRSHH 0T SHETEMEUS C1GHM(bHSED. Ll6TeoT euend Lmwns Amrlg HeTSSHeYLD.

eeuefluly:
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CugGuwssl — e GeoLlener O 6
(Label) &_@meuns@s6d

efleorm:
BuhBwdsenTll LwWeTLbSH EpdsetorL Geollemer (Label) o meunée.

BuiBdasemIll LWeTLbSSH asTbesIUL baer Gelener (Label) o _meaund@se.

&L emM:

1. Start > All Programs > Adobe > PageMaker 7.0 > Adobe PageMaker 7.0 eredTm
auflensuied &efls 1&Lg B LSW CURCLEST HeUETTSHmSS SMEHSHELD.

2. ulliulenLuied File > New ereotuemgs Herfls asiweyn. (sieveog) Ctrl + N ereoremid
eflemsliLenems GSNIGHS auflemwill LweTLbSSeD. && Document Setup 2_emmwimLed
QULIgemWSH SMSHSLD.

3. OK eungsnemenr &efls eswen. @ueurgs Untitled — 1 ereorp euwirfled LHlw
Sp6uetord FHlewruied GHmesTmILD.
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Wn@ ierefithaemean Inches edlmbg Milimeters &@& wrHm Geuesor(hid.

uligbuemLuied File > Preferences > general etedim &L Lemememwid lerflé G1FWWLIGYLD.
(1eve0g) eflemsliLeensuled Ctrl + K erettuems sipsseyn. @ueunpg Preferences
2 _emIuImLed aLLly GHmedrmib.

aifled Measurements wmmib Vertical ruler &¥lnrkig uliglieiuliquied Millimeters eredTLemS s
GCaibHesboHSaLD.

5.

6

7.

8
10.

11.
12.

13.

198

smeILeULIquilellBh& OTSLMHSE thewedd CHIHOSbSHE FEUEUSID 6UEMDTIOLD.
Control Palette &eb width 100 mm erevteyd height 40 mm erevTeyd LMHMEYLD.
uliglin’ emLuied Element > Rounded corners erettuemgé &erfls e1FLILIOLD.

Rounded corners 2 emgwnLed 6QULIquieliphas CHemeuwimesr 6l euSHmSHSH
GaHagbh&HSa|D. SUOLN(IQE QI L (PN 6F6lausHD GHTeTmID.

smellauliquied 6L&eVL chewmend Hlafls aFLIH, EFUSSIDGET QI
9_emISHOSTSGI M ©_(HeUTSHSHELD.

Name : eTe0TLemSS SLL &G 6FILG HIEWLP6)] ellenFemnil SiIRSHSELD.

STD : eretTLEmSS FHLLEFS Q5SS HIEOWE)| elemFemil Si(RSHHELD.

Section : eretTLMSS HLL 56 61FILIG HIEWLPE) 6XlemFMII SH(RSHHELD.

School : eTetTUMSS S L &8 615G HIEWLPE) ElenFenI Si(IRSHSEYLD.

Subject : eretTLEMSS HLLEE Q&L HIEWLE) ElleNFNII Si(IRSHSELD.

EIL&6EVL. ChemEDE C1&T6T0T(h 2_6M (LP(REUMSWD CHITHOSH(HSHE&HEYLD.

ulglulemruiedo Type > Indents / Tabs eteoTUem®s Hlafls QFLWIEYD. (Si6D6DE))
eflemalileemauiled Ctrl + | er6tTLIENS SH(RSHSEULD.

euedg tab g8 90 mm siemeled AUNHSSD. leader AUTSSTem6ETTS Hlafld OFILIZH 6UIHLD
uliquwedled YeraflaGamiemL s Gaameshedeayn. Weotern Apply eunssnenensd el
QFIWeYLD.
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14. @beuns Caemauwiner GeolleT 2_[HauT&HSLILILIHSELD.

eeuefluicy:
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MYSQL: sreyssensdled 2_emer
&HL_Lemel&erfledT LILIeOTLIM(h

1. CREATE - ST6YSHSHEMD LOMHMID ASHETT ALMIHLHEMET 2 _(HeunsH&sed (table,
index, views, store procedure, function, and triggers)

2. ALTER - an&eTBeu SHHGD HT6YHHETHemS LOMMHMILIEHLO GG 6D.

3. DROP - FHTYSHSHETHH D 2_6Tan OUMIHeme H5ESH6D.

4. SELECT- SIEYSHSEMTHHED QD HHEUMED H(IHLOL 6T(hSHSED.

5. INSERT - SIemel (H S Leueneooruied G&T5Hseb.

6. UPDATE - i Leuemetoruied ermaseoTGeu 2 emem HTemen GLODLI(hSEISH6D

7. DELETE- STEYSHET  SLLeUHeTTTUIed 2 6Tem SIWEVTHEISH 5856608 6METIULD
H&ESSH60.

My sql gl LwiedtLhSS DDL wpmito DML elesorenemens 615U160m&&6d

Q&I emM:
1. (MYSQL command prompt emw Hmé&s) XAMPP control panel euflwins

2. BIEYSIHNMSHHL 2 _MhSHEHemLUI LWET QLW (user name) MHMID &L 6YFEIFT6D6m DL
(password) LWedTLI(bSE] 2 _6THIEMLOSHED

3. e&npésiulL DDL MysQL eflermeusmeouiemeor 61&wedLIbSSH QeuefuiiemLLl OLm)s.

SYNTAX:

Based on the below syntax queries are built and executed.

* CREATE DATABASE testDB;

* CREATE TABLE table_name (columnldatatype,column2datatype,column3datatype, ....);
* ALTER TABLE ‘table_name' ADD COLUMN ‘column_name" ‘data_type';

* DROP DATABASE databasename;

*SELECT * FROM TABLE NAME

*INSERT INTO table_name( fieldl, field2,...fieldN ) VALUES ( valuel, value2,...valueN );
* UPDATE table_name SET field1 = new-valuel, field2 = new-value2 [WHERE Clause]

* DROP TABLE table_name ;
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Bl ev:
CREATE DATABASE SchoolDB;

CREATE TABLE student(
studentID int,
LastName varchar(255),
FirstName varchar(255),
Address varchar(255),
City varchar(255)
);
ALTER TABLE ‘'members’ ADD COLUMN "credit_card_number' VARCHAR(25);
DROP DATABASE SchoolDB
SELECT * FROM student
® INSERT INTO student (studentID ,LastName , FirstName,Address,City ) VALUES ®
(“002”, “Ram”;’Kumar”, “ROJA NAGAR”YCHENNATI”);
SELECT * FROM student
UPDATE student SET LastName = ‘SRI’ WHERE studentID = 003;
SELECT * FROM student
DROP TABLE student ;

SELECT * FROM student

QFlLIemM 201
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Database created

Table created:

studentID LastName FirstName Address City
Table Altered
Database dropped
StudentID LastName FirstName Address City
101 C Priya 1, new street Trichy
202 S Ramu 5, North garden Madurai
St
One row inserted.
StudentID LastName FirstName Address City
101 C Priya 1, new street Trichy
202 S Ramu 5, North garden Madurai
® St
002 Ram Kumar ROJA NAGAR  CHENNAI
003 R Krishna Park Street Coimbatore
StudentID LastName FirstName Address City
101 C Priya 1, new street Trichy
202 S Ramu 5, North garden Madurai
St
002 Ram Kumar ROJA NAGAR  CHENNAI
003 SRI Krishna Park Street Coimbatore
Table dropped.
Table not found.
202 LTI Y))
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PHP — suqliuenL. Hlired

sigliuewLPHP firemed 2 meunsdl aeueafluiiemL Q1LmISHeD.

gl emm:
1. Xampp Server (Apache) gl6unki&ged.
2. Goto &l GamiyemméE eseased (Virtual path folder) (c:\xampp\ntdoc)
3. test.php file Gamillemeor 2_(Heunsd), HTemed FLLEFF OFUIS.

4. (http://local host/test.php) ereédTm UL L 6med LWEOTU(BSE 2 _rhiseT euemed 2 _someflulled (web
browser)blTemne0 @uissHaLD.

lmeb:

) <html> ®
<body>

<?php

echo “Welcome to Our School”;
$color = “blue”;

echo “My car is “ . $color . «<br>";
echo “My dress is “ . $COLOR . «<br>";
echo “My box is “ . $coLOR . «<br>";

/I test whether a number is greater than 30, 20 or 10 using ternary operator
functiontrinary_Test($n){

$r=$n > 30

? “greater than 30”

:($n > 20

? “greater than 20”

:($n >10

? “greater than 10”
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: “Input a number atleast greater than 10!”));
echo $n” : “$r’\n”;

}

trinary_Test(32);

trinary_Test(21);

trinary_Test(12);

trinary_Test(4);

7>

</body>

</html>

Qeuefluly:

Welcome to Our School

My car is blue
My dress is
My box is

32 : greater than 30
21 : greater than 20
12 : greater than 10

4 : Input a number atleast greater than 10!
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10.

11.

12.

13.

14.

Business and Commercial Knowledge,
Foundation course by Board of Studies,
The Institute of Chartered Accountants
of India (ICAI)

Business Management Ethics and
Communication, Study Material, Paper-
Il, Foundation Programme, ICSI.

Principles  of
JJAYASANKAR.

Principles of Management by
KATHIRESEN AND Dr. RADHA

Principles of Management by
P.C.TRIPATHI AND P.N.REDDY

Management by

. Principles of Management by L.M.

PRASAD

Business management by Dinkar
Pagarew

Principles  of
J.Jayasankar

management by

Principles of Management by kathiresen
and Dr.Radha

Principles of Management by
P.C.Tripathi and P.N.Reddy.

Principles  of
L.M.Prasad

Principles of Management by Harold
Koontz , Heinz Weihrich and A.
Ramachandra Aryasri.

Management by

Principle of Management — P.N. Gupta
(2005), S. Chand & company Ltd,
New Delhi (First Edition)

Principles of Management, Eighth
Edition — Theory & Franklin (1999)
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15.

16.

17.

18.

19.

20.

21.

22.

A.LT.B.S Publishers and Distributors,
New Delhi ()

Principles and Practice of Management
— T.N. Chhabra (1997) Dhanpat Rai
and Co (pvt.Ltd.), New Delhi.

Principles of Management, Tenth Edition
— Harold Koontz, Heinz Weihrich and
A Ramachandra Aryasri (2004), Tata
McGraw - Hill Publishing Company
Limited, New Delhi

Organizational Behaviour — L.M.Prasad
(1993) Sultan Chand & Sons, New
Delhi

Organizational behavior - Stephen
P. Robbins and Timothy A. Judge (
2013) Prentice Hall, USA

Business Management, Fifth Edition -
Dinkar Pagare (1993) Sultan Chand &
Sons, New Delhi

Principles and Practice of Management,
Sixth Edition - LM Prasad (2005)
Sultan Chand & Sons, New Delhi

Stephen P Robbins, "Fundamentals of
Management: Essential Concepts and
Applications", 5th Edition, Pearson
Education., 2005

R.  Sivarethinamohan and P.
Aranganathan, "Principles of
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